
 

 

 

 

AMITY INTERNATIONAL MOOT COURT COMPETITION 2018 

Amity Law School, Noida, Amity University Uttar Pradesh 

 

RULES, PROCEDURE AND GUIDELINES OF THE COMPETITION 

 

I. DEFINITIONS 

The following terms shall have the corresponding meanings unless otherwise specified: 

I.1. ‘Competition’ shall refer to Amity International Moot Court Competition, 2018. 

I.2. ‘Competition Problem’ shall refer to the compendium of facts and issues released 

by the organizers of the Competition with its clarifications and corrections. 

I.3. Competition Rules’ shall refer to the official rules of the Competition as amended 

from time to time. 

I.4. ‘IST’ shall refer to Indian Standard Time. 

I.5. ‘INR’ shall refer to Indian Rupee. 

I.6. ‘Knock-out round’ shall refer to the Semi-finals and Final rounds of the 

Competition. 

I.7. ‘Memorial’ shall refer to the memorandum of written submissions submitted by       

any participating team as per the Competition Rules. 

I.8. ‘Organizing Committee’ (hereinafter to be referred as O.C.) shall refer to the 

committee appointed for the administration and conduct of the Competition 

including any other authorized persons, and of all events leading up to the 

Competition. 

I.9. ‘Official Email’ shall refer to the official email id of the Amity International Moot 

Court Competition, i.e., aim.alsn2018@gmail.com. 

 

 

 



 

 

II. GENERAL RULES 

a) Eligibility 

II.a.1. All recognized law schools, universities and institutions in India or abroad 
with minimum three year or higher duration of LL.B. courses shall be eligible 
to participate. 

II.a.2. Each participating team shall comprise of three members wherein two (2) 
members, shall be designated as Speakers and one (1) member as Researcher. 

II.a.3. No team shall contradict the composition mentioned above. No faculty 
member, coach, or a designated observer will be allowed to accompany the 
team. 

II.a.4. Accommodation shall be provided to the outstation teams only one day 
prior from the competition, i.e., on 11th October, 2018, 900 hours onwards 
on. Accommodation shall be available to such participants till noon of 14th 
October, 2018, the last day of competition. Teams who intend to arrive prior 
or leave after the specified dates are required to make their own 
arrangements. The teams have to submit the Travel Form by 3rd October, 
2018 23:59 hours IST. 

II.a.5. No pick up and drop off facility will be provided by the institution. The 
participants are requested to arrange their own transportation for the same. 

 

b) Clarifications to the Problem 

II.b.1. Teams may request for clarifications via e-mail to aim.alsn2018@gmail.com 
latest by 27th September, 2018, 23:59 hours IST. 

 

c) Registration 

II.c.1. The participation must be confirmed through an email sent to 
aim.alsn2018@gmail.com by 10th September, 2018, 23:59 hours IST and 
following it up by sending a hard copy of the same through post. 

II.c.2. For Indian teams and for teams participating from SAARC Countries the 
registration fees shall be INR 4500/-through a demand draft in favour of 
‘Amity University, Uttar Pradesh’ payable at ‘Noida’ which must reach the 
Organizing Committee latest by 15th September, 2018. 

II.c.3. All foreign teams (excluding teams from SAARC countries) shall be required 
to pay US $165 or 115€ as registration fee. 



 

 

II.c.4. The participating teams shall be required to send a demand draft for the 
registration fees along with the duly filled registration form and the same 
shall reach to the institution on or before 15th September, 2018. 

 

d) Memorandum 

II.d.1. Each Team participating in the Competition must prepare a memorandum on 
behalf of the Prosecutor/Applicant and on the behalf of the 
Defendant/Respondent. 

II.d.2. Each team must send its memoranda via e-mail to the O.C. at 
aim.alsn2018@gmail.com latest by 1st October, 2018, 23:59 hours IST. Please 
note that NO HARD COPIES ARE TO BE SUBMITTED. 

 
II.d.3. Any memorial submitted after the deadline shall be subject to penalty for late 

submission. 
II.d.4. The Memorial must contain the following parts only: 

i. Cover Page; 
ii. Table of Contents; 
iii. Index of Authorities; 
iv. Statement of Jurisdiction; 
v. Questions Presented; 
vi. Statement of Facts; 
vii. Summary of Pleadings; and  
viii. Pleadings (including Conclusion/Prayer for Relief). 

 

A. Cover Page 
The front cover of each Memorial must have the following information: 
i. The Team Code on the upper right-hand corner followed by ‘P’/’A’ for  

Memorandum on behalf of the Prosecutor and ‘D’/’R’ for Memorandum on 
behalf of the Defendant (e.g., Team allotted code number 23 shall write ‘23P’ on 
the top right hand corner of the front cover of its Memorial for the Prosecutor);
  

ii.   The name of the court; 
iii. The year of the Competition (the year during which the relevant Round takes 

place, for instance, The Amity International Moot Court Competition 2018. 
iv.   The name of the case; and 
v. The title of the document (i.e., ‘Memorandum on behalf of the Prosecutor’ or 

‘Memorandum on behalf of the Defendant’); 
 

B. Index of Authorities 
The Index of Authorities must list all legal authorities cited in any part of the 
Memorial and must indicate the page number(s) of the Memorial on which each 
authority is cited. 
 

 



 

 

C. Citation 
Footnotes must be used to identify the source of statements or propositions made in 
the pleadings of the Memoranda. Endnotes are not permitted. The use of footnotes 
must be restricted to pleadings only. Participants are expected to follow Bluebook 
style of citation, 20th edition. Font size should be restricted to 10, Times New Roman, 
with single spacing. 
 

D. Length 
The limitation on length must be kept in check on the bases of the following 
stipulations: 
i.    The statement of facts, including section headings must be no longer than 2 

pages. 
ii.     The summary of pleadings may not be longer than 2 pages. 
iii. The total length of the Pleadings, including the section headings, 

conclusion/prayer for relief, and any associated footnotes, must be no longer 
than 30 pages. 

 

E. Presentation of the Memoranda 
The Memoranda shall be exchanged by pen drives only. The following colour 
schemes shall be followed for marking of the separate pen drives containing the 
Memoranda: 
Prosecutor/Applicant- BLUE 
Defendant/Respondent- RED 
 

F. Scoring of the Memoranda 

Following would be criteria for judging the Memoranda: 

S. No. PARAMETERS MARKS ALLOTED 

1. Knowledge of law and fact 20 

2. Proper and articulate analysis 20 

3. Extent and use of research 20 

4. Clarity and organization 20 

5. Adherence to the norms regarding 
Style, grammar and citation of 
sources 

20 

 

G. Formatting Specifications: 

1. For Main Text: 

a) Font type: Times New Roman 

b) Font size: 12 

c) Line spacing: 1.5 



 

 

d) Body of text: Justified 

2. For Heading: 

a) Font type: Times New Roman 

b) Font size: 14 

3. For Cover Page: 

a) Font type: Times New Roman 

b) Font size: 16 

 

II.d.5. Team Code 

The participating teams shall be allotted a ‘Team Code’ after the registration. Teams 
‘shall not reveal identity’ in any form, except the Team Code allotted to them during 
the Competition. Names of participants, nation or name of college of the Teams 
concerned must not appear on or within the Memoranda. 

 

e) Procedure for Oral Rounds 

II.e.1. Oral presentations during the round must be made by two (2) members, prior 
to the beginning of the Oral Round. Each Team must indicate to the bailiff 
how it wishes to allocate it’s given time for each round among (a) its first 
speaker, (b) its second speaker. 

II.e.2. Time allocated for but not used by one speaker may not be used by another 
speaker, or in the rebuttal or sur-rebuttal. 

II.e.3. Judges may, at their discretion, extend total oral argument time of the team up 
to 10 minutes beyond the given time slot for such team in any round. 
Speakers asked to further expand upon arguments may, in this instance, 
argue for more than their individual limit for each round. 

II.e.4. The order of the pleadings in each Oral Round at all levels of the Competition 
is: Prosecutor 1 --> Prosecutor 2 --> Defendant 1 --> Defendant 2 --> Rebuttal 
(Prosecutor 1 or 2) --> Sur-rebuttal (Defendant 1 or 2). Once a speaker has 
completed his or her main leading, that speaker may not make any additional 
argument except for rebuttal or sur-rebuttal. This applies irrespective of 
whether the pleading Team uses all of the time it has allocated for the main 
pleading. Further, any time that is not used in the main pleading may not be 
used to extend the time allocated to rebuttal or sur-rebuttal. 

 

 



 

 

A. Rebuttal and Sur-rebuttal 

Each Team may reserve up to five minutes for rebuttal or sur-rebuttal. As a courtesy 
to the judges, Teams should announce whether they intend to reserve time for 
rebuttal or sur-rebuttal at the beginning of their oral argument, and how much time 
they intend to reserve. Failure to announce will not waive the right to rebuttal or 
sur-rebuttal. The rebuttal or sur-rebuttal must be delivered by one of the two 
speakers participating in the oral round. A rebuttal shall immediately follow after 
pleadings of Defendant 2, and the sur-rebuttal shall immediately follow the rebuttal. 
The Team need not indicate prior to rebuttal or sur-rebuttal as to which of the Team 
Members will deliver rebuttal or sur-rebuttal. Teams may waive their rebuttal or 
sur-rebuttal through an express declaration. 

 

B. Scope of Pleadings 

A team's oral pleadings are not in any way limited to the scope of the Team's 
Memorandum. The scope of the Prosecutor's rebuttal is limited to responding to the 
Defendant's primary oral pleadings, and the scope of the Defendant's sur-rebuttal is 
limited to responding to the Prosecutor's rebuttal. If the Prosecutor waive off its 
right to rebut, Defendant may not appear for sur-rebuttal. 

 

C. Scoring of the Speakers 

The criterion for scoring of the Speakers has been given herein below: 

S. No.  CRITERIA MAXIMUM MARKS 

1. Knowledge of law 20 

2. Application of law to facts 20 

3. Ingenuity & ability to answer questions 20 

4. Style, poise, courtesy, demeanour 15 

5. Time management 10 

6. Co-ordination & team work 10 

7. Adequacy of the Prayer 05 

TOTAL 100 

 

D. Court Room Communication 

Written communication during the Oral Round shall be limited to electronic written 
communication among team members seated at the counsel table. No other written 
communication may take place. 

 

 



 

 

E. Scouting 

Team members or persons directly affiliated with any team may only attend 
preliminary rounds in which their team is competing. Violation of this rule should 
be brought to the attention of the court room officers immediately, without 
disturbing the oral round, or immediately after the oral round has finished. A team 
which commits scouting in any form shall be disqualified from the competition. 

 

III. STRUCTURE OF THE COMPETITION 

The Competition shall consist of three Rounds: 

i. Researcher Test* 

ii. The Preliminary Rounds; 

iii. The Semi Finals; and 

iv. The Final. 

The side on which the Team will be arguing will be decided by a draw of lots, with 
the Teams picking the lots. The Teams will be provided with a pen drive containing 
the soft copy of their opponent’s Written Submission prior to the oral rounds. They 
are required to return the same after their rounds. 

*The Researcher’s Test will be conducted online and shall be held on the first day 
of the Competition after the registration of the participating teams i.e., 12th 
October, 2018. 

 

a) Preliminary Rounds 

The preliminary rounds will be held on 12th October, 2018. In the preliminary 
rounds, each Team shall argue once as the Prosecutor and once as the Defendant. No 
team shall be provided any information regarding the identity of their opponent 
teams or any other team under any circumstances. No two teams will argue against 
each other more than once in the preliminary rounds. Each oral session of the 
preliminary round of competition consists of thirty (30) minutes of oral pleadings 
including rebuttals. Prosecutor and Defendant are each allotted fifteen (15) minutes. 
A maximum of three (3) minutes may be reserved for rebuttals and sur-rebuttals. 
The team may not allocate more than 10 minutes, including rebuttal or sur-rebuttal 
to either speaker. The total scores in the preliminary rounds shall be out of 900 
marks (S1 (300) + S2 (300) + Memorial (300). The decision of the judges would be 
final and would not be questioned or changed in any circumstances. 

 

 



 

 

b) Semi Finals/Final Rounds 

The Semi Finals and Final would be conducted on 13th October, 2018. The semi-final 
round of competition consists of eighty (80) minutes of oral pleadings including 
rebuttals. Prosecutor and Defendant are each allotted forty (40) minutes. A 
maximum of five minutes shall be reserved for rebuttals and sur-rebuttals. The final 
round of competition consists of one hundred (100) minutes of oral pleadings 
including rebuttals. Prosecutor and Defendant are each allotted fifty (50) minutes. A 
maximum of five minutes shall be reserved for rebuttals and sur-rebuttals. 

 

IV. PENALTIES 

S. No.  PARTICULARS QUANTUM OF PENALTY 

1.  Delay in submission of Memoranda 2 points per day 

2. Resubmission of Memoranda 5 points 

3.  Formatting violations including: 1 point per type of violation, 
up to a Maximum of 5 points  Use of incorrect font 

Use of incorrect font-size 

Use of improper line spacing 

Use of improper block quote 

Use of endnotes 

4.  Failure to include all parts of Memorandum 
or inclusion of an unremunerated part 
Failure to include necessary and correct 
information on Memorandum cover page 
Excessive length: 

2 points for each part 
2 points (one-time penalty) 

5. Pleadings: 

1-100 words over 3 points 

101-200 words over 6 points 

201-300 words over 9 points 

301-400 words over 12 points 

401+ words over 15 points 

6. Excessive length: Summary of Pleadings 2 points (one-time penalty) 

7. Excessive length: Statement of Facts 2 points (one-time penalty) 

8. Breach of Anonymity of Teams 2 points (one-time penalty) 
*Kindly note that resubmission of the memorials shall be allowed only at the discretion of the 

Organizing Committee. 

 

V. AWARD 

V.1. There will be a Trophy and attractive prizes for the ‘Winning team’ and 
‘Runner-Up team’. 

V.2. There will be a Trophy and attractive prizes for the ‘Best Memorial.’ 



 

 

V.3. There will be awards and cash prizes for the ‘Best Counsel.’ The Best Counsel 
will be determined by highest score of all rounds that the contestant has argued 
divided by the number of rounds. V.4. There will be awards for the ‘Best 
Researcher.’ 

V.4. All participants will get certificates of participation and all the winners of 
awards specified in V.1 to V.3 will get certificates of merit. The certificates will 
only be given to the participants in the Valedictory Ceremony on the final day 
of the competition. It has mandatory for all the participants to attend the 
Valedictory Ceremony. The Institution will not courier the certificates. 

 

VI. MISCELLANEOUS 

VI.1. The O.C. reserves the right to amend, modify, change or repeal any of the 
competition rules at any stage. The O.C. shall communicate any changes 
made in the competition rules to the Participating Teams. 

VI.2. If a team believes that violation of the rules of the competition has taken place 
at any stage of the competition, the team(s) within half an hour after the 
completion of the round in which violation has allegedly occurred should 
register a complaint with the Grievance Cell which will be constituted 
specifically for such purpose. Team(s) under no circumstances shall approach 
the Judges with any complaints. 

VI.3. The Director’s decision shall be final in all matters concerning the competition. 

 

ADDITIONAL RULES PERTAINING TO E-MOOT 

VII. RULES PERTAINING TO SUBMISSION OF MEMORIAL & COMPENDIUM 

VII.a. The teams have to format the table of contents of their respective memorial in 
a specified hyperlink format as specified in Annexure-A annexed herewith. 

VII.b. The compendium has to be submitted to the organizing committee through 
pen drives on the date of registration. 

VII.c. The Compendium should only be one PDF file, for easy accessibility of the 
judges. (No hardcopies of compendium is permitted) 

 

 

 

 

 



 

 

VIII. Miscellaneous Rules 

The teams are supposed to refer to the documents on computers only, but can use 
hard copies of the bare acts and books if need be, although the same is not 
encouraged. 

 

The O.C. on behalf of the Moot Court Society wishes all the very best to the 
participants… 

 

CONTACT DETAILS: 

Moot Court Society 

Amity Law School, Noida 

Block I-2, Amity University Campus 

Sector-125, Noida – 201301 

Email ids: mcs.alsnoida@gmail.com and aim.alsn2018@gmail.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

ANNEXURE- A 

Guidelines for Memorial (with regard to formatting of the Table of Contents) 

 

Each Team participating in the Competition must adhere to the following guidelines 

with regard to the formatting of the TABLE OF CONTENTS. 

 The Table of Contents must be hyperlinked for the ready reference of the 

Judges. 

 Herein below, for your convenience, we have enlisted the steps to insert Table 

of Contents in Microsoft Word. Also, we have provided video links for the 

same. 

 

HOW TO INSERT TABLE OF CONTENTS IN WORD? 

In order to include or insert automatically a “Table of Contents” into your paper or 

document, simply start writing your paper as you would normally do. 

It is important, however, to make a couple of decisions beforehand: 

1) Decide before hand the type and size of the font for each level of the headings. 

You might want each level to be different or you might want all of the headings to 

look the same. 

Example: Heading Level 1 = EVERY WORD CAPITALIZED and in BOLD 

Heading Level 2 = First Letter of Each Word Capitalized  

Heading Level 3 = Only First letter of first word capitalized  

Heading Level 4 = Only first letter of first word capitalized in italics 

2) Decide how you want to number the Headings (Titles and sub-titles). Example: 1, 

1.1, 1.1.1 and so on. Or 1, 1a, 1.a.1 and so on; Or I, I.1, I.1.1; Or A, A.a A.b and so on; 

Or A, A.1, A.2, A.2.1 and so on or any other numbering style. 

Once the decision about the font style, font size and Heading level style is made, you 

are ready to begin. 

 

 

 



 

 

STEPS TO CREATE A TABLE OF CONTENTS 

Once you have completed the digitization of your document making the decisions 

suggested above (Font style, size, and Heading style), follow the following easy 

steps: 

1) Highlight the first Level 1 Heading on the document. 

2) At the “Home” tab, go to the “Styles” Section and click on the “Heading 1” 

bottom. 

3) Repeat these steps for each heading, indicating its level at the “Styles” Section 

under the “Home” tab…that is, Heading 1 button, or Heading 2 or Heading 3 and so 

on. 

4) Place the cursor at the beginning of the document. 

5) Click on the “References” tab. 

6) At the “Table of Contents” Section under the “References” tab, click on the “Table 

of Contents” drop down arrow. 

7) Choose the preferred style. 

Automatically, the Table of Contents will be placed above the first page of the 

document 

 

To Change or edit the Pattern of the Headings 

1) At the “Home” tab, “Styles” Section, click the “Change Styles” drop down arrow. 

2) Chose the style/pattern you desire 

Automatically, all of the Headings in the document will change according to the 

style chosen. However, the Table of Contents style will remain the same. 

 

To Edit the Table of Contents 

1) DO NOT edit the table of contents directly. 

2) Make the necessary changes, (additions and deletions) directly on the document. 



 

 

3) To add a Heading to the Table of Contents, highlight the added heading on the 

document, and click on the correct “Heading” button (i.e. Heading 1, or Heading 2, 

etc.) at the “Styles” Section from the “Home” Tab. 

4) At the “Reference” Tab, go to the “Table of Contents” Section, click on the “Table 

of Contents” drop down arrow, and choose “Insert Table of Contents” option at the 

bottom. 

5) To delete a Heading, simply delete it on the document. 

Repeat Step 4 above 

 

Video Links 

 Microsoft Word 2007  

https://www.youtube.com/watch?v=OkyisWIE3kQ 

 

 Microsoft Word 2010 

https://www.youtube.com/watch?v=EMVv-Pnil3M 

 

 Microsoft Word 2013 

 https://www.youtube.com/watch?v=gExEfR7wQMs 

 

 

 

 

 

 

 

 

 

 


